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DynaVox T10/T15 User’s Guide
Introduction
The DynaVox® T10 and T15 are an integrated hardware and software solution for AAC, which 
feature the DynaVox Compass™ communication software.

This User’s Guide provides an overview of the basic operation of your T10 and T15 Android 
4.0.4 tablets. It points out key hardware features, briefly explains how to customize the pages 
and their content, and describes the most frequently-used features and functions of your 
device.

Resources
This User’s Guide is only a brief, introductory reference for your DynaVox device. Many other 
resources are available.

NOTE

On your device open the Settings menu. Then select Help. A menu will open with links to 
myDynaVox.com to access documentation, Help Videos, and the Knowledgebase.

myDynaVox

myDynaVox.com is your personal online storage and administration website that you can use 
to manage the Compass software running on your device. It is available to you from anywhere 
via the web.

Go to www.myDynaVox.com to register for an account.

Your myDynaVox account integrates you with a community of clinicians, technical experts, and 
your peers and provides you with a responsive community of help and support.

 After you set up your account, you can access it from anywhere on the web to:

• Register your device

• Upload, download, and share communication pages

• Receive software updates and new communication content

• Backup and restore page sets

• Access implementation and therapy supports and tools

• View and participate in discussion forums

• Find technical support and documentation resources

• Search the Knowledgebase

• View help videos

• Manage your user profile
Part # 401438-T15 1



Additional Documentation

A Quick Start Guide was shipped with your DynaVox device. This guide provides an overview 
of your device, walks you through starting up and customizing it, and provides information on 
resources available to you on both myDynaVox.com and through the Help menu on your 
device.

Support

NOTE

Before you open a new case, write down the serial number of your device. It can be found on the 
bottom edge of your device..

 My serial number is:______________________________

Technical Support

www.myDynaVox.com > Community & Support > myDynaVox Community

Visit the online library to access Knowledgebase articles, research product tips, and 
perform custom searches, or visit the Community Q&A section.

Or - if you have a problem with your device, start the repair process by opening a new 
case.
2
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Hardware Overview

T10 BLOCK DIAGRAM

T15 BLOCK DIAGRAM
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CAUTION

The LCD may show "image persistence" if the same image or page is displayed for four (4) 
consecutive hours or longer. The visual artifacts may or may not be noticeable or distracting. They 
will not cause permanent damage to the LCD.

Front: 1 Charging Indicator: Lit amber when the battery is charging. Turns 
blue when the battery is fully charged.

2 Power Button: To turn the T10 on, press and hold until the splash 
screen appears. Press and release to put to sleep. To shut down the 
T10, press and hold until the shutdown menu appears.

3 Front-facing Camera: Takes photographs of people and objects in 
view of the T10 screen - for example, self portraits.

4 Ambient Light Sensor: Adjusts the screen brightness based on 
the surrounding light.

Top 5 Speakers: Dual speakers provide an extensive range of volume.

6 Volume Rocker Switch: Press on the + side of the switch to 
increase volume. Press on the - side of the switch to decrease 
volume. 

Right Side 7 Speaker/Headphone/External Microphone Jack: Connect an 
external speaker, headphones for private audio, or an external 
microphone.

Back 8 Rear-facing Camera: Use for taking custom photos to share with 
others or to put on your communication pages.

9 Lanyard connections: Provide attachment points for the T10 strap.

Bottom 10 Charger Port: Plug in the adapter/charger to charge the battery.

11 Micro USB Port: Connect to a micro-USB to full-size USB cable 
adaptor. (DynaVox does NOT recommend the use of a USB hub.)

12 30-Pin Dock Connector: (for future use)

13 Micro HDMI Port: Connect an external monitor to your T10.

14 Built-in Microphone: Record speech and custom sounds.
6
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CAUTION

The LCD may show "image persistence" if the same image or page is displayed for four (4) 
consecutive hours or longer. The visual artifacts may or may not be noticeable or distracting. They 
will not cause permanent damage to the LCD.

Front: 1 Power Button: To turn the T15 on, press and hold until the splash 
screen appears. Press and release to put to sleep. To shut down the 
T15, press and hold until the shutdown menu appears.

2 Front-facing Camera: Takes photographs of people and objects in 
view of the T15 screen - for example, self portraits.

3 Ambient Light Sensor: Adjusts the screen brightness based on 
the surrounding light.

4 Charging Indicator: Lit amber when the battery is charging. Turns 
blue when the battery is fully charged.

Top/Right 
Side

5 Speakers: Dual speakers provide an extensive range of volume.

6 Volume Rocker Switch: Press on the + side of the switch to 
increase volume. Press on the - side of the switch to decrease 
volume. 

7 Front-Facing Infrared Window: Sends and receives infrared 
signals. Use your T15 as a universal remote control.

8 Micro SD Card: Connect to a micro SD card, for personal storage 
only.

9 Full-Size USB Port: Connect to a full-size USB drive. (Maximum 
current for the full-size USB is 2.0≤1A.)

10 Speaker/Headphone/External Microphone Jack: Connect an 
external speaker, headphones for private audio, or an external 
microphone

11 Switch Jacks(2): Connect external switch(es) for scanning access.

Back 12 Rear-facing Camera: Use for taking custom photos to share with 
others or to put on your communication pages.

13 Rear-Facing Infrared Window: Sends infrared signals.

14 Lanyard connections: Provide attachment points for the T15 strap.

Bottom 15 Lanyard connections: Provide attachment points for the T15 strap.

16 30-Pin Dock Connector: (for future use)

17 Charger Port: Plug in the adapter/charger to charge the battery.

18 Micro USB Port: Connect to a micro-USB to full-size USB cable 
adaptor. (DynaVox does NOT recommend the use of a USB hub.)

19 Micro HDMI Port: Connect an external monitor to your T15.

20 Built-in Microphone: Record speech and custom sounds.
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This device complies with part 15 of the FCC Rules. Operation is subject to the following two 
conditions:

• This device may not cause harmful interference.

• This device must accept any interference received, including interference that may cause 
undesired operation.

Adapter

For safe and optimal performance, the adapter should be kept within the following parameters:

Adapter Model: MTP451BX - 120300

DC Max Rating: 12V 3A

Adapter Voltage Range: 100-240V, 50/60Hz, 1.5A
10
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Charging the Battery
When the battery charge is low, the device will emit an audible beep. You should plug in your 
device and recharge the battery immediately.

1. Plug the charger supplied with your device into a wall outlet. 

2. Connect the charger to the charger port on the device.

The charging indicator will glow amber while your device is charging. It will turn blue when 
it is fully charged.

3. After your device is fully charged, disconnect the charger.

You can’t overcharge the battery. It is fine to charge the battery overnight.

You can use the device while the battery is charging.

The T10 battery model is 5860103P/4000mAh/7.4V.

The T15 battery model is HX-5570138/5850mAH/7.4V.

CAUTION

Because of internal chemical reactions, battery performance may deteriorate over time. In 
addition, failure to keep the conditions of use (charge, discharge, ambient temperature, etc.) within 
specified ranges may shorten the battery life expectancy, or damage your device. If the battery 
cannot maintain a charge for long periods of time, even when it is charged correctly, it may need to 
be replaced.

CAUTION

For safe and proper operation of your DynaVox device, use only chargers, batteries, and 
accessories that have been approved by DynaVox Technologies.
Part # 401438-T15 11



Temperature/Humidity/Atmospheric Pressure 
Ranges

For optimal device performance, the T10/T15 should be kept within the following ranges:

NOTE

Run time will be shortened at the high and low ends of the temperature range.

Mounting/Transporting Your T10/T15
If you use your device while in a wheelchair, you should have it properly mounted for both 
communication and transportation purposes. Wheelchair mounting systems are available 
through DynaVox. 

Protective and accessible carrying cases are also available. Consult the DynaVox website 
(www.dynavoxtech.com) or your DynaVox sales consultant for more information. 

Product Cleaning/Handling
To clean your device, first turn it off and then wipe it gently with a damp cloth or soft paper 
towel. You may dampen the towel with a mild window cleaner to remove fingerprints, food 
particles, and dust. Do not use tape or stickers on either the touch screen or the case, as they 
are difficult to remove and may damage the device surface. Tape, stickers, and other sticky 
materials can damage the touch screen and interfere with the operation of the device. 

Be sure to avoid getting your device wet. Never submerge it in water (e.g., dishwasher). If your 
unit accidentally gets wet, be sure to shut it down and allow it dry thoroughly. If after 24 hours 
you find that the device seems to function normally, there is probably no damage. If it fails to 
function or behaves abnormally, go to www.myDynaVox.com > Community & Support > 
myDynaVox Community to start the repair process by creating a new case. You may need to 
ship it to DynaVox for repairs. 

Be careful not to drop it. Such treatment is not recommended and can shorten the life of your 
device. Do not use a sharp object to make selections on the touch panel, as this can cause 
damage. Use your finger or a special capacitive stylus.

CAUTION

Never, under any circumstances, disassemble your device. Doing so for any reason will void the 
warranty, and you will be responsible for the cost of any required repairs.

Activity Temperature Range

Using the device 32°F - 104°F (0°C - 40°C)

Charging the battery 32°F - 113°F (0°C - 45°C)

Storing 14°F - 113°F (-10°C - 45°C)

Relative humidity Up to 90%

Atmospheric pressure 80 - 106kPa
12
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Turning the T10/T15 On For The First Time
Press the Power button to turn on your device. Select the DynaVox icon on your desktop.

DYNAVOX ICON ON DESKTOP

The Setup Wizard screen will open.

SETUP WIZARD SCREEN

The Setup Wizard will walk you through the steps to create a new user and choose an 
appropriate page set.

When setup is complete, a Congratulations screen will open.

CAUTION

If your device freezes or hangs or presents error messages, you may need to close programs or 
reset the device to regain functionality.

CAUTION

Any system upgrade or installation must be done by a DynaVox technician. If you are not a 
resident of North America, please call the dealer from whom you purchased the device. DynaVox 
can provide the Standard Operating Procedure for the upgrade or installation of any DynaVox 
system apps.
Part # 401438-T15 13



CONGRATULATIONS SCREEN

From the Congratulations screen, you can:

• View orientation videos. (The Orientation tab will, by default, be open. Select the video 
thumbnail to launch the orientation videos.)

• Select the myDynaVox tab for information on the myDynaVox.com website. (See 
myDynaVox.)

• Select the Resources tab for a list of resources available on the myDynaVox.com website 
to support your use of the DynaVox Compass software.

When you have viewed the videos and learned about the myDynaVox.com website, select the 
Start Communicating button. You are now ready to start communicating!
14
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The Tool Bar

TOOLBAR (EXAMPLE)

Depending on the pageset you are using, a Toolbar may be 
present on your screen. The Toolbar is designed to give you quick 
access to your most-used tools and pages.

The appearance of the Toolbar may vary. It can be customized 
and configured to your specifications - you can add or remove 
buttons and folders, hide the Toolbar, and even move it from the 
left side of the screen to the top, bottom, or right side of the 
screen. (See Interface Settings.)

The Settings button in the Toolbar (circled in the illustration to the 
left) opens the Settings menu, which provides you with easy 
access to the tools you need to customize the DynaVox Compass 
software. (See The Settings Menu below.)
Part # 401438-T15 15



The Settings Menu
The Settings menu gives you access to the Page Browser, Page Creator, Vocabulary, 
Interface and Toolbar settings, Voice Settings, Rate Enhancement components, the camera 
and media library, access method settings, backup and restore functions, as well as links to 
help documentation and videos.

SETTINGS MENU

NOTE

Depending on the pageset you are using, a Levels button may be present in the Settings menu. 
See Levels.
16



DynaVox T10/T15 User’s Guide
Open the Settings Menu

There are two methods of opening the Settings menu, depending on whether or not your 
Toolbar is visible onscreen:

Open the Settings Menu if the Toolbar is Visible:

Simply select the Settings button on the Toolbar.  The Settings menu will open.

Open the Settings Menu if the Toolbar is Not Visible

1.  Select the Edit button in the top right corner of your screen.

EDIT BUTTON

If the Toolbar is hidden, a dialog will open presenting you with two options:

2.  Select the Settings button. The Settings menu will open. 

REFERENCE

When the Toolbar is enabled, the Settings button will always be visible on your screen. See 
Interface Settings for instructions on enabling the Toolbar.
Part # 401438-T15 17



Settings

Page Browser

The Page Browser is the quickest way to open or edit a page. You can search for a page by 
name, or look through the folders and see preview images of pages before opening them.

Open the Settings menu. (See Open the Settings Menu.) Then select Page Browser.

PAGE BROWSER (EXAMPLE)

The icons at the top right of the screen (circled in the illustration above) enable you to display 
the pages and folders as a grid (default) or list.

Use the arrow button at the upper left of the screen (circled in the illustration above) to move 
up through the layers of folders. Select a folder to open it and display the pages inside. Select 
a page, and a large thumbnail of the page will open.

SELECTED PAGE IN PAGE BROWSER

Simply select Open to open the selected page or Editor to edit the page.
18
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Page Creator

Create an entirely new page - either from a template, or based on the layout of an existing 
page. You can customize your new pages with your own content - vocabulary, symbols, media 
files, etc.

Open the Settings menu. (See Open the Settings Menu.) Then select Page Creator.

PAGE CREATOR

The icons at the top right of the screen (circled in the illustration above) enable you to display 
the pages and folders as a grid (default) or list.

Select from a number of templates (blank or by activity type or instructional area) or select the 
Like Page tab to create a new page using the layout of an existing page. You can also use the 
Search text field to find a page you would like to use as a template.

Use the arrow button at the upper left of the screen (circled in the illustration above) to move 
up through the layers of folders. Select a folder to open it and display the pages inside. Select 
a page, and then select Create at the top right corner of the screen. A dialog will open - name 
the page and browse for a location for it. You can then edit the page to your exact 
specifications.
Part # 401438-T15 19



Vocabulary 

Your vocabulary (your talk topic choices, word lists, and phrases) was selected when you used 
the Setup Wizard to set up your user account and is based on your input regarding your age, 
gender, condition, and communication level. 

Most vocabulary items are stored in folders. You can edit, copy, delete, change the order of 
appearance onscreen, and add new vocabulary items using the Vocabulary menu.

Open the Settings menu. (See Open the Settings Menu.) Then select Vocabulary.

VOCABULARY MENU

Select the Word Lists, My Phrases, or Topics button.
20
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VOCABULARY MENU - WORD LISTS (EXAMPLE)

Navigate through the folders (use the arrow button at the upper left of the screen - circled in the 
illustration above) - to move up through the layers of folders. Select a folder to open it.

When you find the folder or item you wish to edit, select Manage at the top right corner of the 
screen. 

NOTE

If you are adding a new folder or item, navigate to the level at which you want to add the folder or 
item, then select Manage.
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EDIT VOCABULARY MENU (EXAMPLE)
22
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When you select the Manage button, a button bar will open.

BUTTON BAR ON VOCABULARY SCREEN

Select the item you want to modify. Then select the applicable button on the button bar.

• Edit - The Vocabulary Properties panel will open to the default Edit tab.

VOCABULARY PROPERTIES PANEL

Enter a new label, browse for a symbol, and add or change the message.

NOTE

The Message field will not be present when you are editing a folder.

Select the Properties tab in the Vocabulary Properties panel to change the age and ability 
level for the item you are editing.

• Copy To - The Select a Folder screen will open. Navigate through the levels to find the 
destination folder.

• Order - Use the First, left arrow, right arrow, or Last buttons at the top of the screen to 
reorder the selected item.

• New Folder - Create a new folder. Use the onscreen keyboard to enter a label and symbol 
for the new folder. Select the Properties tab in the Vocabulary Properties panel to define 
the age and ability level for the new folder.

• New Item - Create a new item. Use the onscreen keyboard to enter a label, symbol, and 
message for the new item. Select the Properties tab in the Vocabulary Properties panel to 
define the age and ability level for the new item.

• Delete item - Select the trash can icon .
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Interface Settings

The Interface Settings menu enables you to adjust or define how certain objects are presented 
onscreen. The Interface Settings menu is organized by tab, with each tab pane presenting a 
different group of controls and options.

Open the Settings menu. (See Open the Settings Menu.) Then select Interface. The 
Interface Settings menu will open to the default General Settings tab.

INTERFACE SETTINGS - GENERAL SETTINGS

General Settings - Enable or disable (hide) the Toolbar, choose a location on the screen for 
the Toolbar and the Navbar. Select a Home Page and Keyboard page. Password protect page 
editing and access to the Settings menu.

When you have finished customizing your general settings, select the green Done button at 
the top right corner of the screen.
24
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INTERFACE SETTINGS - MESSAGE WINDOW SETTINGS

Message Window Settings - Customize the settings for your message window: use symbols, 
auto-capitalize words at the beginning of a sentence, auto-space between words, use a 
thicker, more visible cursor, clear the message window after speech, speak as words are 
entered into the message window, and/or show misspellings.

When you have finished customizing your message window settings, select the green Done 
button at the top right corner of the screen.

INTERFACE SETTINGS - BUTTON SETTINGS
Part # 401438-T15 25



Button Settings - Animate the symbols on your buttons and track button usage.

When you select Enabled and Display Usage, usage counts will appear on each button. (See 
the illustration below.)

DISPLAY BUTTON USAGE (EXAMPLE)   

When you have finished customizing your button settings, select the green Done button at the 
top right corner of the screen.

INTERFACE SETTINGS - AGE & ABILITY LEVEL

Age & Ability Level Settings - Changes the content based on your selection of age and 
ability level.

When you have finished customizing your age and ability level settings, select the green Done 
button at the top right corner of the screen.
26
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Access Method Settings

The DynaVox device allows you to choose and refine a selection method that best suits your 
needs. 

Open the Settings menu. (See Open the Settings Menu). Then select Access Method.

ACCESS METHOD SETTINGS WITH SCANNING SELECTED

Simply select the access method that you would like to use. 

NOTE

Simple Touch is the default selection method.

When you make a selection on the Access Method menu, a Settings button will appear (circled 
in the above illustration). Select the Settings button to open a menu that will enable you to 
customize the settings for your selected selection method. (For example, to set hold and 
release times for the Touch Enter and Touch Exit selection methods.) 

The Settings menu for the Scanning selection method is pictured below.
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EXAMPLE OF ACCESS METHODS SETTINGS MENU  

Use the access method Settings menu to customize the access method you have selected. 
When you have chosen your preferred settings, select the green Done button at the top right 
corner of the screen.

NOTE

T15 only: You may use the Switch Ports 1 - 2 for your scanning needs.
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Toolbar Editor

You can personalize the Toolbar - add a new button or folder, edit or delete buttons or folders, 
move them up or down the Toolbar, and hide items on the Toolbar.

Open the Settings menu. (See Open the Settings Menu.) Then select Toolbar Editor. This 
menu shows all of the buttons and folders - both hidden and visible - in your Toolbar.

CONFIGURE TOOLBAR SETTINGS

Select Manage at the top right corner of the screen to edit the Toolbar. A button bar will open at 
the top of the Configure Toolbar menu that will let you edit your Toolbar.

 BUTTON BAR ON CONFIGURE TOOLBAR MENU

Select New Button or New Folder to open a dialog and add a new button or folder, or select a 
folder or button (a blue check mark will appear on the item), and then select Edit, Move Up, 

Move Down, Hide (Show), or select the trash can icon  to delete the item.

NOTE

Selecting a hidden item in the list will change the Hide button to Show on the button bar.

When you have finished customizing your Toolbar settings, select the green Done button at 
the top right corner of the screen.
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Voice Settings

You can select and customize a speaking voice for your device as well as manage 
pronunciation exceptions for frequently used words.

Open the Settings menu. (See Open the Settings Menu.) Then select Voice Settings.

 VOICE SETTINGS

• Select a speaking voice from the Voice drop-down list.

• Select the Download & Manage Voices button on your DynaVox device to delete voices 
or to download voices from myDynaVox.com and install them.

NOTE

The Download & Manage Voices button will only be enabled on your T10/T15 device.

When you select the Download & Manage Voices button, the Manage Voices menu will 
open. 
30



DynaVox T10/T15 User’s Guide
MANAGE VOICES MENU

Select the trash can icon  to delete a voice, or the Install button  to download and 
install a voice.

NOTE

Preinstalled voices are designated as Read Only and cannot be deleted.

• Manage Pronunciations:

The speaking voice may not always say words correctly - especially in the case of proper 
names and some foreign-derived words. You can save alternate text or phonetic spellings 
of words to correct any pronunciation problems.

Select the Manage Pronunciations button to open the Pronunciation Exceptions dialog. 
Select the Manage button at the top right corner of the screen and then select either the 
New Text Exception or the New Phoneme Exception button. A dialog will open. Use the 
onscreen keyboard to type the word, and then type the phonetic spelling (or select the 
appropriate phonemes). Then select Save (or OK for phonemes) to close the dialog and 
save the pronunciation exception.
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TEXT EXCEPTION DIALOG (EXAMPLE)

• Use the Volume slider to adjust the speaking volume.

• Use the Rate slider to adjust the speaking rate. Dragging the slider from left to right 
increases the speech rate.

• Select the Speak button next to Voice Preview to hear how the voice sounds at the 
selected volume and rate of speech.

• Words in the message window will, by default, be highlighted as they are spoken - select 
Disabled from the Highlighting drop-down list if you don’t want spoken words to be 
highlighted. To customize highlighting, select the Configure button. On the Highlighting 
menu that opens, select a highlighting type and style from the drop-down lists.

When you're satisfied, select the green Done button in the upper right corner of the screen.
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Rate Enhancement Settings

The DynaVox Compass software offers rate enhancement features that can help you 
communicate more quickly and efficiently.

Both abbreviation expansions and word prediction allow you to use the onscreen keyboard to 
enter only a few letters in the message window, and the software will anticipate word choices.

Open the Settings menu. (See Open the Settings Menu.) Then select Rate Enhancement.

RATE ENHANCEMENT SETTINGS

Abbreviation Expansions

You can compile your own list of abbreviations for frequently used words (for example, names 
of friends, family, places, pets, etc.). 

NOTE

Make sure that the Auto Expand Abbreviations check box is selected to use the abbreviations 
you create.

1. Select the Manage Abbreviations button, and the Abbreviation Expansions menu will 
open.

ABBREVIATION EXPANSIONS MENU

2. Select the Manage button.

3. Select the New button, and the Edit Abbreviation Expansion dialog will open.
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ABBREVIATION EXPANSIONS MENU WITH EDIT ABBREVIATION EXPANSION DIALOG OPEN

4. In the Abbreviation text box, use the system keyboard to type a few letters that represent 
the word you are abbreviating. (For example, enter "fl" for "Fluffy."

5. Type the entire word in the Expansion text box.

6. Select Save.

7. Select Done in the upper right corner of the screen.

To expand the abbreviation, just type it into the message window. It will automatically expand 
after entering a space.

NOTE

Please note that the abbreviation must be entered into the message window exactly as it 
appeared when you created it. For example, if the abbreviation you created is "als" (without 
spaces between the letters), entering "a l s" into the message window will not expand.

Word Prediction

Word prediction can be used on any page that includes predictor buttons. As you compose a 
message, the prediction feature anticipates your word choices and displays vocabulary 
options for quick selection - these vocabulary options are displayed on the predictor buttons.

You can activate and deactivate prediction features using the Rate Enhancement Settings 
menu. Select or clear the following check boxes on the Rate Enhancement Settings menu to 
enable/disable the following word prediction features:

• Enable Prediction - Word prediction is enabled by default. Clear the check box to disable 
automatic word prediction.

• Show Symbols with Predictions - This feature is also enabled by default. Clear the 
check box to hide symbols.

• Predict Words only Once - When the Predict Words only Once check box is selected, 
you have only one chance to select a word in a predictor button. If you do not select a 
word, that word will not be predicted again until after you complete the word you are 
entering - by adding ending punctuation or a space.
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Camera Settings

Open the Settings menu. (See Open the Settings Menu.) Then select Camera.

CAMERA

1 Opens your Media Library, and, if an image has been snapped, also saves 
that image.

2 Switches the camera from rear facing to front facing.

3 Select to snap a photograph. After an image has been snapped, the Snap 
Image button updates to New Image. Selecting New Image saves the 
current image to your Media Library and snaps another image.

1 2 3
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Media Library

The Media Library is a viewer for all of your photos and videos. Videos and any photos that 
you take from your device’s camera will be displayed in folders under the Images and Videos 
tabs.

Open the Settings menu. (See Open the Settings Menu.) Then select Media Library.

MEDIA LIBRARY (EXAMPLE - IMAGES)

When you select a folder under the Images tab and then select a specific image, a full-screen 
photo viewer will open.

.

Use the Previous and Next buttons at the top of the screen to scroll through all of the images 
in the folder.

Select the Videos tab to open your video library. Select a videos folder, and then select the 
video file you want to play. Then select Open on the Options dialog.
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Backup/Restore Settings

When you completed the Setup Wizard in a page set, you saved many settings for the page 
set, vocabulary, media library, rate enhancement information, selection method settings, etc. A 
backup file saves these customized settings.

Open the Settings menu. (See Open the Settings Menu.) Then select Backup/Restore.

BACKUP/RESTORE SETTINGS

You can backup and restore your user file either locally (to a folder on your device or a USB 
drive) or to myDynavox.

Backup to myDynaVox.com

1. Select the Backup to myDynaVox button.

2. If you are prompted, sign in to your account by entering your username and password.

3. Enter a name (and description [optional]) for your backup file in the text box. (It’s a good 
idea to include the date in the file name.)

4. Select OK.

Backup Locally

You can back up on the device or to a USB drive. 

• T10 - You must use the Micro USB OTG adapter. (Insert the adapter into the micro USB 
port on your device. Then plug the USB drive into the adapter.)
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• T15 - You can back up using either the Micro USB adapter or a full-size USB drive. (Either 
insert the Micro USB adapter into the micro USB port on your device. and then plug the 
USB drive into the adapter, or insert a full-size USB drive into the USB port on your 
device.)

1. Select the Backup Locally button. 

2. On the screen that opens, select a destination directory (backups is the default backup 
folder). Use the arrow button at the upper left of the screen to move up through the layers. 
of directories. Select a directory in which to save your backup file or locate your USB 
drive.

3. Select the green Select button in the top right corner of the screen.

4. Enter a name for your backup file in the text box. (It’s a good idea to include the date in the 
file name.)

5. Select OK.

CAUTION

Backing up locally to your device does not save your backup file "off system" if your device is lost 
or damaged.

Restore from myDynaVox.com

1. Select the Restore from myDynaVox button.

2. If prompted, sign in to your account by entering your username and password.

3. The Select Backup File screen will open. Select the backup file you want to restore. If 
necessary, use the arrow button at the upper left of the screen to move up through the 
layers of directories.Then select the green Select button in the top right corner of the 
screen.

4. Select OK. A progress bar will appear.

CAUTION

Selecting this option will reset the device and overwrite all user data, settings, and content.

Restore Locally  

• T10 - You must use the Micro USB OTG adapter. (Insert the adapter into the micro USB 
port on your device. Then plug the USB drive into the adapter.)

• T15 - You can restore using either the Micro USB adapter or a full-size USB drive. (Either 
insert the Micro USB adapter into the micro USB port on your device. and then plug the 
USB drive into the adapter, or insert a full-size USB drive into the USB port on your 
device.)

1. Select the Restore Locally button. The Select Backup File screen will open, displaying all 
of the backup files in the Backups folder. 

2. Locate the file you want to restore. If necessary, use the arrow button at the upper left of 
the screen to move up through the layers of directories. Select your backup file or locate 
the file on your USB drive.
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3. Select the backup file you want to restore. Then select the green Select button in the top 
right corner of the screen.

4. Select OK. A progress bar will appear.

CAUTION

Selecting this option will reset the device and overwrite all user data, settings, and content.

Manage Login

Sign out/sign in to your account.

Help

Links to myDynaVox.com to access documentation, help videos, and the Knowledgebase are 
available on the Help menu. Use the Help menu to check for updates or find the End-User 
License Agreement and information on the software version and serial number of your device.

Open the Settings menu. (See Open the Settings Menu.) Then select Help.

HELP MENU
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Levels

Depending on the pageset you are using, a Levels button may be present on the Settings 
menu. The Levels menu enables you to quickly and easily choose among ability levels to get 
the most appropriate tools and content and grid size.

The Levels menu also provides access to overview videos and allows you to configure your 
topic and keyboard layouts

Open the Settings menu. (See Open the Settings Menu.) Then select Levels.

LEVELS SETTINGS (NAVBAR PAGESET)

1. Select an appropriate level from the Ability Level tabs at the top of the screen.

NOTE

Select the Intro to Levels button at the top left of the screen and watch the video for more 
information on levels.

2. Customize your settings Under Configure Tools. 

3. When you are done, select the green Done button at the top right corner of the screen.
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The Editing Toolbar at a Glance
The Editing Tolobar contains all of the tools that you will need for creating and editing pages.

EDITING TOOLBAR

1. File

New Create a new page.

New From Template Create a new page from a template or "like" an existing 
page.

Save Save all the changes you have made to the page that is 
currently open.

Open Opens the Select Page menu to open a new page to edit. 
(Opening a new page will close the currently open page.)

Revert Cancel all the changes you have made to the currently 
open page since you last saved it.

Page Size Select a page size (or create a custom page size) that 
anticipates the positions of the Navbar and Toolbar (Left, 
Right, Top, Bottom, or Off).

Macros Opens the Macro Editor.
Preferences Change editor preferences.
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2. Edit

NOTE

The Edit options will vary, depending on the selected object(s) on the page. For example, if a tab 
control is selected, there will be an option for adding a new tab. (The options shown in the 
illustration above are for a group button.) 

Undo Undo the last change you made. (The Compass software 
allows multiple levels of undo and redo.)

Redo Redo the last change you made. (The Compass software 
allows multiple levels of undo and redo.)

Delete Permanently remove the selected object from the page.

Duplicate Copy the selected object and place the copy immediately 
next to the selected object.

Cut Remove the selected object(s) from the page and save to 
the clipboard so the object(s) can be pasted back onto the 
page or onto another page.

Copy Make a duplicate of the selected object(s) and save to the 
clipboard so the object(s) can be pasted back onto the 
page or onto another page.

Select Parent Change the selection to contain the "parent" object of the 
object that was originally selected. For example, if a 
button within a group box is selected, the "parent" of the 
button would be the group box.

Select Content Select all content (including label, symbol, and all objects 
in a group button or group box) in the selected object.

Clear Contents Remove all content (including label, symbol, audio cue, 
and all objects in a group button or group box) from the 
selected object.
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3. Select

Select Select a single object on the page (or the page itself).

Multi Select Select multiple objects on the page. (This tool replicates 
holding down the Ctrl key on a keyboard while clicking on 
multiple objects with a mouse.)

Spray Spray out copies of a selected object to make a 
rectangular grid.

Scan Order Set the order in which the objects on the page will scan.

Lock “Lock” an object so that it will not be editable. Selecting 
the Lock tool will place lock icons  on each object on 
the page (including the page itself). Select each object 
that you want to lock. Its lock icon will change from green 
to red, indicating that it is locked. (To unlock the object, 
select the Lock tool again and then select the object you 
want to unlock.)

Measure Gives the measurements of the selected object or area.
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4. Buttons

To place a button on the page, simply select the appropriate button tool and then select a 
location on the page.

To draw out a button on the page, touch the screen and use your finger (or mouse if using the 
editing software) to draw out the button.

To resize the button, select it, and then move your finger (or mouse) over the edge or corner of 
the button until a double arrow appears. Drag until the button is the size and shape you want.

After you have drawn the button, select it, then select the Properties button in the top left 
corner of the button. (See the illustration below.)

Standard Place a "standard" (rectangular) button.

Group Place a group button. 

(A group button is a button into which you can place other 
objects [a "multi-object" button]).

Word Predictor Place a word predictor button. 

(A word predictor button anticipates the user’s word 
choices as a message is composed in the message 
window.)

Phrase Predictor Place a phrase predictor button. 

(A phrase predictor button works on the same principle as 
a word predictor button but will predict a phrase.)

Rectangular Hotspot Place a rectangular hot spot. 

(Hot spots are usually placed over portions of images or 
visual scenes on a page. Then the hot spot is programmed 
so that when it is selected, an action will be performed.)

Invisible Hotspot Place an invisible hot spot. 

(An invisible hot spot can have actions assigned to it, but it 
has no borders, color, symbol, or other visible 
characteristics.) 

Freeform Button Draw a button of any shape you want. (Touch the screen 
and move your finger [or mouse if using the editing 
software] around the page until the button is the size and 
shape you want.)
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PROPERTIES BUTTON

The Button Properties panel will open. Use the Button Properties panel to assign a label, 
message, and symbol to the button, change its appearance, and apply actions. See Editing a 
Button.

5. Label (Non-button Objects)

Label Place text anywhere on the page. 

Symbol Place a symbol anywhere on the page. 

After you have placed the symbol - a bounding box (or 
"placeholder") will appear on the page - select the 
Properties button in the top left corner of the bounding box. 
The Symbol Properties panel will open and enable you to 
select the symbol you want.

Message Window Place a message window on the page.

Tab Control Place a tab control. 

(To add additional tabs, select the tab control. Then select 
Edit > New Tab.)

Group Box Place a group box on the page. 

(A group box acts as a "container" for groups of buttons, 
check boxes, radio buttons, or other objects.)

Vocabulary Grid Place a vocabulary grid on the page. 

After you have placed the vocabulary grid, select the 
Properties button in the top left corner of the grid to browse 
for and select a vocabulary source.

Video Place a video object on the page. 

After you have placed the video object, select the 
Properties button in the top left corner of the object to select 
a video.

Line Place a line on the page. (To draw out a line on the page, 
touch the screen and use your finger [or mouse if using 
the editing software] to draw out the line).
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Text Box Place a text box on the page. 

(Text boxes are similar to message windows in that they 
display text messages entered by keyboard input. They 
differ from message windows, however, in that text boxes 
are used for short text entries - only one word or line of 
text.)

Check Box

Radio Button

Place a check box or radio button on the page.

By default, each radio button/check box includes a frame 
in which a symbol will appear when it is selected.

Radio buttons and check boxes share the same 
properties. The major difference between them is that in 
each group of radio buttons, only one selection is allowed. 

Check boxes, however, work independently of one 
another and are useful when multiple selections are 
allowable.
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6. Layout

NOTE

The Layout options will vary, depending on the selected object(s) on the page. (The options shown 
in the illustration above are for two buttons - with labels - selected.)

Arrange

Arrange objects on the page. (Objects on a page are layered and can overlap.)

• Bring Forward - Move the selected object up one layer.

• Bring to Front - Reposition the selected object as the top item on the page.

• Send Backward - Move the selected object down one layer.

• Send to Back - Reposition the selected object as the bottom item on the page.
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NOTE

If you have multiple objects selected on a page, the "primary" object is the object displaying the 
Properties button.

Align

Adjust the relative positions of multiple selected objects on the page by aligning the 
selected objects on the page based on the position of the primary object.

Center 

Center the selected objects on the page horizontally, vertically, or both horizontally and 
vertically. 
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NOTE

If only one object on a page is selected, the options available in the Size menu are Full Width, 
Full Height, and Full Size. (The selected object will fill the width of the page, the height of the 
page, or fill the entire page.)

Size 

Resize all of the selected objects. The resulting size is based upon the primary object - the 
object displaying the Properties button. (That is, all selected objects will be resized to 
match the size of the primary object.)

• Same Width - Resize the selected objects to the same width.

• Same Height - Resize the selected objects to the same height.

• Same Size - Resize the selected objects to the same size.

• Fill in Parent - Resize the selected objects to the size of their parent object while 
retaining their shape.

• Gridify - Resize the selected objects to fit within the background gridlines.

• Gridify in Parent - Resize and reshape the selected objects to fill their parent object.

Alphabetize 

Adjust the relative positions of objects on a page alphabetically - based on their labels.
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7. Exit

Swap 

Exchange the positions of two selected objects. (The contents of the objects will remain 
with the original object)

(This option is only available if two objects on the page are selected.)

Spacing 

Adjust the horizontal and vertical spacing of three or more selected objects on the page.

(This menu option is only available if three or more objects on the page are selected.)

 

Closes the Editing Toolbar.

(A confirmation dialog will appear asking if you want to save changes to the page.)
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Editing a Button
Editing a button is a fast, easy way to quickly customize your pages. 

1. Select the Edit button in the top right corner of your screen. (See the illustration below.)

NOTE

If the Toolbar is disabled, when you select the Edit button, a dialog will open with two options: Edit 
Page or Settings (to open the Settings menu). Select the Edit Page button.

EDIT BUTTON

2. Select the button to be modified.

3. Select the Properties button in the top left corner of the button. (See the illustration below.)

SELECT THE PROPERTIES BUTTON
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The Button Properties panel will open.

BUTTON PROPERTIES PANEL - CONTENT TAB OPEN 

The Button Properties panel contains five tabs:

Content Tab

On the Content tab, you can assign a label, a message, a symbol, and apply actions that will 
execute when that button is selected.

1. Label - the label will appear on the face of the button.

a. Select the Label field.

b. Type the new label using the onscreen keyboard.

c. Select OK.

2. Message

The message will not appear on the face of the button. Messages can be used for a more 
lengthy or more complex line of text. For example, if the label of the button is "Address," 
the message could be the user's actual address. When using messages, be sure to assign 
corresponding actions. (See Actions below.)

a. Select the Message field

b. Select the Replace button.

c. Type the new message using the onscreen keyboard.

d. Select OK.

3. Symbol

Symbols help users associate concepts more quickly and easily. To assign a symbol:

a. Select the blue Select... button next to the Symbol field. Symbols based on the label 
you entered will be suggested, but you can search for different symbols using the 
search field at the top of the screen. Just select the Search field, and use the 
onscreen keyboard to type what you're searching for. As you are typing, a dynamic 
search will return symbols that match your search criteria.

b. Touch the symbol to select it. When a symbol is selected, a blue check mark will 
appear over the symbol. To choose a different symbol, just select a new one. The first 
choice will automatically deselect.
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SELECT A SYMBOL

c. Select the green Select button at the top right corner of the screen.

4. Actions

Actions make the button do something. Whether you want to speak a label directly from a 
button or compose text in a message window, you'll need to assign actions to your button.

To assign actions:

a. Select the Edit... button next to Actions...

b. From the drop-down list, select what kinds of actions you're looking for. For example, 
if you're assigning actions to a button, select Buttons from the list. This will show you 
a list of popular button actions.
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SCRIPT EDITOR-PULL-DOWN MENU

c. A list of available actions will display in the window on the left. For example, if you 
selected Buttons, button actions will be displayed with a brief description of each 
action.

d. Select the action to assign to your button. As you make your selections, actions 
assigned to your button will appear in a list in the window on the right.

To delete actions, make selections from the list of assigned actions, and select the red 

trash can icon  at the top of the screen.

e. After assigning actions, select the green Done button at the top right corner of the 
screen.

Font Tab

Font choices are available for all text, including button labels. Select the Font tab to choose 
font types, styles, sizes, and colors. 
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FONT TAB

Layout Tab

LAYOUT TAB

The Layout tab enables you to change the button type. If you wish to change the button type, 
use the Type drop-down list to select a new button type from the following button type choices:

• Standard - buttons most often contain a label, a symbol, and have assigned actions.

• Group - buttons contain multiple, smaller buttons. Using group buttons can often help 
those who use the scanning access method easily make faster choices.

• Word Prediction - A Word Prediction button anticipates the next logical word choice and 
displays various options for quick selection. Typically used on keyboard and spelling 
pages, these buttons can greatly enhance the rate at which the user communicates.

• Phrase Prediction - Similar to Word Prediction, Phrase Prediction buttons anticipate 
logical phrases.

In addition, various layout options (placement of symbol and label) are available to 
accommodate the user's preferences and needs. Select the Layout drop-down list to choose a 
layout for the button.
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Style Tab

Many style choices are available, including theme styles and colors, border colors and 
thickness, and button shapes.

STYLE TAB

Misc Tab

For auditory scanning users, a field for an audio cue is provided. To enter an audio cue:

1. Select Replace.

2. Type the new audio cue using the onscreen keyboard.

3. Select OK.

To hide the button, select the check box next to Hidden.

If you wish, assign an object name to the button. (An object name is a unique property that 
identifies an object on a page for programming purposes.)

MISC TAB

NOTE

Did you make a mistake? Just select Edit from the Editing Toolbar. You can Undo, Redo, or even 
Duplicate a button. If you've made several changes, but want to revert back to the original state of 
the page when you entered Edit mode, select File from the toolbar, then select Revert.
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Cautions - Handling, Storage, and Shipping
While handling, storing, or shipping, please pay attention to the labeling on the package.
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Important Information About Your Device

Your DynaVox device meets all necessary international safety standards and has been tested to meet 
IEC 60601-1 requirements. The DynaVox T10/T15 systems are considered to be portable devices that 
are intended for continuous operation, not intermittent use. The devices have electrical input ratings of 12 
VDC/3.0 Amps. These devices comply with Part 15, Class B of the FCC Rules. Operation is subject to 
the following two conditions: (1) these devices may not cause harmful interference, and (2) these devices 
must accept any interference received, including interference that may cause undesired operation. 
These devices are also tested to Canadian standard ICES-003. To ensure safe operation, you should 
take care to note the following cautionary items:

CAUTION

Your DynaVox device contains a Lithium Ion battery. A safety hazard may develop when the 
battery is placed in or near fires or stoves, or in locations with temperatures above 113 ° F (45 ° 
C). These conditions may cause the battery to generate heat or explode.

CAUTION

Do not perforate, disassemble or modify the battery. If you must dispose of the battery, do so in 
accordance with the local laws that apply to the area where you live.

CAUTION

For safe and proper operation of your DynaVox device, use only chargers, batteries, and 
accessories that have been approved by DynaVox Technologies.

CAUTION

This device presents a risk of electrical shock if the casing is opened. Do not open the casing that 
surrounds the device.

CAUTION

The DynaVox devices are not suitable for use in the presence of flammable anesthetics.

When you are charging your device, remember that the main outlet that you will be using to 
power the adapter must be accessible from within 6 feet (2 meters) of the device. There 
should be no switches or disconnect devices in the ground conductor. The devices require no 
routine maintenance other than a periodic inspection of the power cords for signs of wear and 
damage. If the power cords show signs of wear and damage, they should be replaced.

CAUTION

Do not modify this equipment without authorization from the manufacturer.

CAUTION

The device may be mounted to a wheelchair or fixed on a table. Running the device for a long 
time may cause the temperature to temporarily rise to above 105 ° F (41 ° C). Please power off 
the device if it is overheating.

CAUTION

In case of need, a DynaVox technician can provide a schematic diagram or other technical files.
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DynaVox T10/T15 User’s Guide
Intended Use of This Product
The DynaVox T10 and T15 devices are intended for use as an augmentative communication 
aid, computer access, and environmental control unit for those with speech, language, 
physical, and cognitive disabilities. Their intended purpose is to compensate for lack of speech 
due to injury or handicap, and to provide a means of controlling the environment for persons 
who are unable to reach environmental control equipment due to injury or handicap.

Your device is intended for everyday communication situations. It should not be relied upon as 
a means of communicating emergency medical information. We recommend having multiple 
ways to communicate information during a medical emergency.
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Caution

FCC Warning

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: 
(1) this device may not cause harmful interference, and (2) this device must accept any interference 
received, including interference that may cause undesired operation.

Changes or modifications not expressly approved by the party responsible for compliance could void the 
user's authority to operate the equipment.

Note: This equipment has been tested and found to comply with the limits for a Class B digital device, 
pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against 
harmful interference in a residential installation. This equipment generates, uses and can radiate radio 
frequency energy and, if not installed and used in accordance with the instructions, may cause harmful 
interference to radio communications. However, there is no guarantee that interference will not occur in a 
particular installation. If this equipment does cause harmful interference to radio or television reception, 
which can be determined by turning the equipment off and on, the user is encouraged to try to correct the 
interference by one or more of the following measures:

• Reorient or relocate the receiving antenna.

• Increase the separation between the equipment and receiver.

• Connect the equipment into an outlet on a circuit different from that to which the receiver is 
connected.

• Consult the dealer or an experienced radio/TV technician for help.

RF Warning for Portable device: 

The device has been evaluated to meet general RF exposure requirement. The device can be used in 
portable exposure condition without restriction. 

FCC RF Exposure Statement

The exposure standard for wireless devices employs a unit of measurement known as the Specific 
Absorption Rate (SAR). The SAR limit set by the FCC is 1.6 W/kg. The highest SAR level measured for 
this device is <0.425W/kg, so this device meets the FCC Requirement.

IC Warning

English:

This device complies with Industry Canada license-exempt RSS standard(s). Operation is subject to the 
following two conditions: (1) this device may not cause interference, and (2) this device must accept any 
interference, including interference that may cause undesired operation of the device.

French:

Le présent appareil est conforme aux CNR d'Industrie Canada applicables aux appareils radio Exempts 
de licence. L'exploitation est autorisée aux deux conditions suivantes : (1) l'appareil ne doit pas produire 
de brouillage, et (2) l'utilisateur de l'appareil doit accepter tout brouillage radioélectrique subi, même si le 
brouillage est susceptible d'en comprom ettre le fonctionnement.

Declaration of Conformity

[DynaVox Systems LLC] hereby declares that this [T15] is in compliance with the essential requirements 
and other relevant provisions of Directive 1999/5/EC.
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